Cooper Control Interface
CL4/CL5 Control
User Guide

Doc. #KA2048-514, Bulletin #00050
July 31, 2000
COOPER POWER SYSTEMS
COOPER CONTROL INTERFACE
CL4/CL5 CONTROL USER GUIDE

Information in this document is subject to change without notice. Companies, names, and data used in examples herein are fictitious unless otherwise noted. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose without the express written permission of Cooper Power Systems, Inc.

©1998-2000 Cooper Power Systems, Inc. All rights reserved.

Cooper Control Interface is a trademark of COOPER INDUSTRIES.

Microsoft, MS-DOS, and Windows are registered trademarks of Microsoft Corporation. Windows 95/98 and Windows NT are trademarks of Microsoft Corporation.
CONTENTS

Chapter 1 Introduction ................................................................. 1

Chapter 2 Getting Started .......................................................... 2
   System Requirements ............................................................ 2
   What's in This Package ......................................................... 2
   Installing and Configuring .................................................... 2
      Installing In Windows 95/98/NT ...................................... 3
   What's in This Manual ......................................................... 4
   What's Not in This Manual ................................................... 4
   Where To Get Help ............................................................ 4

Chapter 3 Starting and Stopping the Program ................................. 5
   Windows Start Menu .......................................................... 5
   Windows Desktop Shortcuts ................................................. 5
   Exit .................................................................................. 5

Chapter 4 Working With Readings and Settings ................................. 6
   What are Readings and Settings? .......................................... 6
   Create New Settings .......................................................... 6
   Open Existing ................................................................. 7
   Convert Settings Version .................................................... 7
   Reviewing and Changing Data ............................................. 7
      All Settings .................................................................... 7
      Individual Settings ....................................................... 8
      Communications Settings ............................................. 8
      Readings ...................................................................... 9
   Saving the Data on Your Computer ..................................... 11
   Deleting Data from Settings and Readings ............................ 11
   Printing Reports ............................................................... 12

Chapter 5 Working With a Control .................................................. 13
   Communicating Through the Server .................................... 13
   Making the Connection ...................................................... 13
      Modem Connection ....................................................... 14
   Receive the Control Settings and Readings ......................... 14
   Send Commands to a Control ............................................ 15
   Reset the Indicators in a Control ....................................... 15
   Set the Control Clock ....................................................... 15

Chapter 6 Moving The Settings and Readings ................................ 16
   What Can Be Moved? ........................................................ 16
   Move Data From One File To Another File On The Same Computer ......................................................... 16
   Move Data From One Computer To Another Computer ........... 16
   Move Whole Data Files From One Directory To Another Directory ......................................................... 17
   Move Whole Data Files From One Computer To Another Computer ......................................................... 17

Chapter 7 Troubleshooting and Operating Tips ............................... 18
   Can't communicate with a Control ....................................... 18
Reports won’t print ................................................................. 18
Lost the Readings ................................................................. 18
For additional troubleshooting assistance ............................. 18

Appendix A Manually Starting The CCI DDE Server .................... 19
Windows Start Menu ............................................................ 19
Windows Desktop Shortcuts .................................................. 19

Appendix B Setting Up Communications To A Control ............... 20
Configuring the CCIDDE Server ........................................... 20
PC Port Configuration ........................................................ 20
Adding A New Control From DDE Server ............................ 20
Adding A New Control From The Interface Program ............. 21
How The CCIDDE Server Works ........................................ 21
Using The CCIDDE Server With Other Programs ................... 21

Appendix C Error Code Definitions and Solutions ..................... 22

Glossary ................................................................................. 25
Baud Rate ........................................................................... 25
Communications Port ......................................................... 25
Communications Protocol .................................................. 25
Control ID ........................................................................ 25
Control Type ...................................................................... 25
Data Port .......................................................................... 25
Demand Metering Date/Time Stamp .................................... 25
Dynamic Data Exchange (DDE) ........................................... 25
Reading ............................................................................. 25
Settings ............................................................................ 26
Chapter 1 Introduction

The Cooper Control Interface CL4/CL5 Control program is a powerful, interactive Windows tool to send and receive data from a CL-4C, CL-5A, CL-5C, CL-5D, and CL-5E Regulator Control, and to review readings and update settings while off-line from the Control.

Here is a list of some of its features:

- Easy to use Windows screens with simple menus, scrolling lists of choices and simple mouse-click selections.
- On-screen messages show acceptable data ranges.
- Create settings by modifying an existing file and saving it with a new name.
- Print reports on any Windows compatible printer without difficult printer and report configuration steps.
- Communication to a Control through a new server for simplified configuration and connections.
- The Cooper Control Interface™ program helps you maintain controls. Field technicians can interact directly with Controls. Engineers in an office can work with a copy of the settings and readings from a Control.
- Build settings for a new Control from scratch or copy and modify the file from another Control on a computer in the office, then copy the settings to a laptop computer to send to the Control in the field.
- Build standard configuration settings and use them to setup new Controls to ensure that similar Controls will have similar setups.
- Receive readings and settings into a laptop computer from a Control in the field, and then transfer the data files to an engineering computer in the office for analysis and reporting. Look at saved readings and settings files to compare setups and results to help make engineering recommendations.
- Operate and interrogate a Control, and update its settings from the laptop PC in the field.
- The files, both settings and readings, are in a non-proprietary format (Microsoft Excel) for easy use by other applications, such as spreadsheets and databases.
- Year 2000 compliant.

New Features in Version 2 of Cooper Control Interface

- Supports Windows NT.
- Modem support for the 2179 protocol.
- Supports international and regional settings.
- Convert settings from one version to another version.
- Supports CL-5E controls.
Chapter 2 Getting Started

System Requirements
The Cooper Control Interface program can run on systems with Windows 95/98 or
Windows NT (4.0 with Service Pack 3 or later) operating systems. This version of the
software supports only 32-bit operating systems and is not compatible with Windows
3.1. If you must run on Windows 3.1, then install the version 1.02 of Cooper Control
Interface from the Ver_1.02 subdirectory of the CD.

Connection to a control requires an available RS-232 serial port.
Any Windows compatible printer can be used to print reports.

What's in This Package
The Cooper Control Interface program package includes an installation CD and this
manual. The CD includes the programs, on-line help files, factory default settings,
sample readings, support files, and copies of this user guide.

Communications through the control’s data port requires a Data Port-to-Computer
Interface cable. This cable is not part of this package but can be purchased separately.

This package does not contain floppy disks for installation. If you require floppy disks,
run the MakeFloP.bat program from the CD on a computer that has both a CD drive and
a floppy drive and follow the prompts. Otherwise, contact your Cooper Power Systems
representative to request floppy disks.

Installing and Configuring
The installation CD contains a setup program that will guide you through the installation
process. In most cases, you should accept the default answers it proposes for each
question. You may want to change some of the options but be sure to read the
recommendations on each screen.

The installation CD may contain a “ReadMe.txt” file with new information that became
available after this manual was printed. The installation program will ask if you want to
view the file.

The CCI DDE communications server will be installed as needed.

This installation will not overwrite the default settings file or sample readings file. If
you are repairing or re-installing and want the original files to be installed, then you
must first delete or rename the existing files.

This installation uses standard Windows procedures.
Installing In Windows 95/98/NT

1 Quit all running applications.
2 Insert the CD in the CD drive.
3 Click the Start button and choose Run.

4 Type d:\setup in the Run box and click "OK". These instructions assume your CD drive is D. If you are using a different CD drive, substitute your drive letter in place of D.

5 Follow the instructions on the screen to complete the installation.
What's in This Manual

This User Guide describes the Cooper Control Interface CL4/CL5 Control program and the basic procedures you can do with it. It tells you about the system requirements and how to install it.

It also describes the DDE communications server that is used to communicate with attached controls. You most likely will not need to read about the server unless you are an advanced user who needs to set up a new control type.

What's Not in This Manual

This manual does not discuss how to use Windows dialog boxes and menus, how to use the keyboard and mouse, or other computer operation functions. The manuals with your computer and the on-line help in Windows can show you how to do these tasks.

Nor does this manual discuss the details of the CL-4C, CL-5A, CL-5C, CL-5D, and CL-5E Controls. You will need the Service Information Manuals for the Controls for guidance on how to set and interpret the settings and readings. These manuals are S225-10-4C for the CL-4C control and S225-10-10 for the CL-5A, CL-5C, CL-5D, and CL-5E. For copies of these manuals, contact your local Cooper Power Systems representative.

Where To Get Help

You can get help showing you how to do the basic procedures by choosing Help from the menu or clicking the help toolbar button in the program. Look at the "How do I …" sections for most common questions or check the table of contents for specific items.

You can get help on the screen by pressing the F1 function key.

The Service Information Manual (S225-10-4C or S225-10-10) for the Control you are working with will tell you how to set it up and help you analyze the data.

See also Chapter 7 Troubleshooting and Operating Tips.
Chapter 3 Starting and Stopping the Program

Windows Start Menu
The installation adds the Cooper Power Systems program group to the start menu.
To start the Cooper Control Interface CL4/CL5 Control program, click on the Start button and select Programs. Then click CL4CL5 in the Cooper Power Systems group:

![Windows Start Menu Screenshot](image)

Windows Desktop Shortcuts
For convenience, you can place a shortcut to CL4CL5 on your Windows desktop. You can find instructions for creating shortcuts in the Windows Help on the start menu.

If you have a shortcut on your desktop, simply double-click on the icon to start the program.

![Shortcut Icon](image)

Exit
Exit from the program by choosing File | Exit on the menu or clicking Exit on the toolbar.

![Exit Icon](image)
Chapter 4 Working With Readings and Settings

What are Readings and Settings?

Some windows in the program display only the informational part of a reading from a control where you can view the information and print reports, but you cannot change the data. Other windows display settings and allow you to change them. Settings for a control are stored as “settings” records in the computer database, and readings from the same control are saved as “readings” records. When you work with data records stored on your computer, you choose to open either settings or readings, depending on what work you intend to do.

Settings- Settings are the control programming parameters that set up how the control operates. The Cooper Control Interface lets you receive the settings from a control so you can review them, change them, or save them for later use. Settings that you have changed but not saved are displayed in blue. The program also lets you create new settings and upload them to a control. A settings file on your computer can be transferred to another computer for review and modification. You can receive a settings file from someone else and upload it to a control attached to your PC. See Chapter 6 in this manual for how to import and export settings to your PC.

Readings- A reading is settings plus the output of metering, load profile, and event/profile recorders in the control. The metering, load profile, and event/profile recorder data tell you how the system and device that the control operates with is performing. The Cooper Control Interface lets you receive the readings from a control so you can analyze them. You can view them on the screen and print reports. A readings file can be sent to another computer for review. See Chapter 6 in this manual for how to copy readings to other PCs.

Create New Settings

You can build settings for a new control by selecting File | New Settings from the menu or by clicking the New Settings button on the toolbar. You will be asked to choose settings from an existing file as a base for the new settings. The existing file you choose can be a readings file; the program will get only the settings from the file.

Readings saved from the Cooper Control Interface Data Reader program can be selected. New settings can be based on settings and readings from the MS-DOS based program after they have been converted to the dbf file format.

Settings and readings from the MS-DOS based program may be converted to the dbf file format by using the Database Translator (DB Trans) utility. Execute the DB Trans utility and select the files you wish to translate. These would typically be in subdirectories ending in “.CKT” under the “C:\DATAREAD” directory (e.g. “C:\DATAREAD\DEV15.CKT\”). The DOS-style files are named according to the device ID and end in “.DAT”. Select as many of these as you wish and click on the “Convert” button to have them translated into DBF format. The readings and settings thus converted will be placed in files named “READINGS.DBF” and/or “SETTINGS.DBF” in the same directory.

After all the settings are correct, you can save them in a file or send them to a control.
Open Existing . . .

If you have settings or readings stored in files on your PC, you can open them in the program. Choose Open Settings or Open Readings from the File menu or click one of the open buttons on the toolbar. You will be asked to choose the file that contains the data, and then select the reading or settings you want to view. The existing file you choose can be a readings file; the program will get only the settings from the file. Or you can choose Recent Settings or Recent Readings from the File menu. You will be asked to select a recent reading or setting.

The settings you open from a file can be modified and saved or sent to a control. The file you open could have been saved during a communications session with a control, or it could be from another computer.

Readings saved from the Cooper Control Interface Data Reader program can be selected. Settings and readings from the MS-DOS based program can be opened by this version of the program after they have been converted to the dbf file format. See above, Create New Settings, for information on how to convert data files from the MS-DOS based program to the dbf file format.

Convert Settings Version

You can convert the current settings to a different version. Choose Convert Settings Version from the File menu.

You will be asked to which version the settings should be converted. Select the new version and click OK. The program will perform the conversion and inform you of the results.

Convert Settings Version is available only when the program contains settings.

Reviewing and Changing Data

For more information on how to interpret settings and readings, see the Service Information Manuals (S225-10-4C or S225-10-10).

All Settings

Use "All Settings" to display Basic Control, Configuration, Soft Add-Amp, Voltage Limiter, Voltage Reduction, Profile Recorder, and Security settings in one dialog.

“All Settings” is displayed automatically when you get new settings or open settings. Changes you make on this screen will be displayed immediately in the corresponding individual setting dialog if they are open. If you make a change in one of the individual setting dialogs, it will also be displayed immediately in the All Settings view.

• Blocking Status

Blocking Status can be set and viewed on this screen. Blocking status also appears on the Operate screen.
Individual Settings

- **Basic Control Settings**
  Set and view the basic voltage regulator operating parameters including forward and reverse values for set voltage, bandwidth, time delay, and line drop resistance and reactance. Also change the Reverse Sensing Mode settings.

- **Configuration**
  Set and view control configuration data including the control identification, wiring configuration (Wye or Delta), control operating mode, and sensor and type information. Also display - but not set - the date and time in a connected control. See the "Set Control Clock" menu choice to set the date and time.

- **Soft Add-Amp**
  Set and view the parameters for the software add-amp feature of the control. Available only for the CL-5E and later versions of controls.

- **Voltage Limiter**
  Set and view the voltage limiter mode, and the high and low output voltage limits of the regulator.

- **Voltage Reduction**
  Set and view the regulator voltage reduction settings of the control.

- **Profile Recorder**
  Select the four instantaneous values that will be tracked in the control profile recorder. Available only for the CL-5A and later versions of controls. For CL-5E and later versions of controls, select the period at which the control will record the values.

- **Security**
  View the control manual access security codes (passwords). Set and view the Security Override Code for the CL-5A and later versions of controls.

  **NOTE:** See the discussion of security codes in the Service Information Manual (S225-10-10) before changing the Security Override code.

Communications Settings

- **Communications Settings**
  Set and view the communications parameters for the control. This does not affect the PC. Only the values appropriate for the connected control are displayed.

  **NOTE:** Settings from this dialog are not included in "All Settings".
Readings
• **Instantaneous Metering**  
Displays instantaneous meter readings from the regulator sensors. Not available when settings are being viewed.

• **Demand Metering – Forward**  
**Demand Metering – Reverse**  
Displays demand metering values from the control. See the Service Information Manuals (S225-10-4C or S225-10-10) for an explanation of the metering and reporting algorithms. Not available when settings are being viewed.

Click the reset button to reset the values. Click on the selection boxes to choose which items to reset. If you mark none, the program will ask if you want to reset all of them. Reset is not available unless the program is communicating with a control or has just obtained a reading from a control.

• **Status**  
Displays the status of the control functions. Not available when settings are being viewed.

• **Diagnostics**  
Displays diagnostic data about the processor in the control. Not available when settings are being viewed.

Click the reset button to reset the values. Click on the selection boxes to choose which items to reset. If you mark none, the program will ask if you want to reset all of them. Reset is not available unless the program is communicating with a control or has just obtained a reading from a control.

• **Calibration**  
View the calibration values for the control. Not available when settings are being viewed.

• **Profile Data**  
Display profile data from a CL-5A or later versions of controls for four metered values recorded once every 15 minutes over the past 30 hours. The program obtains profile data only once, either when the dialog is first displayed or when communications are started. When communicating over 2179 protocol, the control resets the profile data automatically after sending it to the PC. Not available when settings are being viewed.

• **Operations Counters**  
Display the operations counters for the control. Not available when settings are being viewed. Available only for the CL-5E and later versions of controls.

• **Operate**  
Use this dialog to operate a control while communicating from the program. Change the tap position and the blocking status. The dialog also displays the metering values that are available on the front panel of a control. Available only while communicating.

When you click a button, the program sends the command to the control immediately. It does not change the settings in the program on your PC. Your display screen will be updated when the control sends information to the PC.
Saving the Data on Your Computer

The interface program can contain settings and readings that were obtained from a control during communications. Or it may contain settings that you got from another file and may have changed.

You can save the data on the disk in your PC for later use:

- If you are communicating with a control, you must stop communications. When you stop communications, the program asks if you want to keep the settings or obtain the readings from the control.
  Choose to keep the settings if you want to save them. Obtain the readings if you want to save those instead.
- Select File | Save or click the diskette button on the Toolbar. If you are not already working on a file that you opened with Open Readings or Open Settings, Save will behave like a Save As so you can name the file you are saving.
- Select File | Save As if you want to create a new file and supply a name for it.

Settings and readings can only be saved to a spreadsheet (xls) file. If you attempt to save to an existing database (dbf) file, you will be asked whether or not to convert the database file to a spreadsheet file. The conversion creates a new file. The original database file is not changed.

The program will save the data as settings or readings, depending on which type is in the program at the time.

You can save the data on your hard drive or on a floppy disk.

Note: The program was not intended to be used with a common central database (e.g. on a network). Saving data from more than one PC to the same database at the same time can produce unpredictable results.

Deleting Data from Settings and Readings

You can delete selected readings and settings from your computer files when you no longer need them. Other data in the same file will not be deleted.

Choose Delete Readings or Delete Settings from the File menu, and then select the file that contains the data you want to delete.

The program will list the readings or settings contained in the file you select. Choose one or more to delete.

Deleting data from a file does not affect the data currently in the program.

Deleting all readings or settings from a file does not delete the file itself. You can delete the file by using the Windows Explorer.
Printing Reports

You can print the settings and readings in reports. Choose File | Print on the menu or click the print button on the toolbar. The program asks you what data to include from the reading or settings that it currently has. Reports for settings contain the function code, value, unit of measure, and description. Reports for profile data contain entry number, time, and the four-parameter values.

If you would like to see the report before printing it, use the File | Print Preview menu choice or click the print preview button on the toolbar. While in print preview, you can:

- Change pages by using the arrow buttons.
- Send the report to the printer by clicking the printer button.
- Export the report to miscellaneous destinations (including text file) by clicking the export (envelope) button. Follow the screen prompts.
- Change the magnification by clicking the magnify button.
- Return to the program by closing the print preview window.
Chapter 5 Working With a Control

Communicating Through the Server

You can connect your PC to a Control to receive settings and readings from it, to send new settings to it, and to operate it.

The Cooper Control Interface communicates with a control through a CCIDDE Server program that starts automatically when you ask for a connection. The CCIDDE Server handles the protocol conversions and communications channel control for each type of control. See Appendix B Setting Up Communications To A Control for more information about the server.

Making the Connection

If you are connecting to the data port:

1. Connect the Data Port-to-Computer Interface cable from the COM port on your PC to the Data Port on the control.

2. Choose Control | Start Communicating from the menu or click the Start Communicating button on the toolbar. The Select Control dialog will be displayed.

3. Click on the Data Port button. The program will get the control identification from the control and try to match it to one of the configured controls. If one match is found, you will be asked to confirm that it is correct. If more than one match is found, you will be asked to choose the correct control from among the matches. If no matches are found, you will be asked to enter a name for the new control and the control will be automatically configured in the DDE server. Instead of clicking on the data port button, you can select a configured control from the list and click OK.

4. The status on the Toolbar will show COMMUNICATING when the connection is ready.

If you are connecting to the communications port:

1. Connect a serial cable from the COM port on your PC to the serial connection of the control.

2. Choose Control | Start Communicating from the menu or click the Start Communicating button on the toolbar. The Select Control dialog will be displayed.

3. Find the control you want in the list and select it. If the control is not in the list, then you must add it by using the DDE Server (see Appendix B Setting Up Communications To A Control). Click OK to start communicating.

4. The status on the Toolbar will show COMMUNICATING when the connection is ready.
Modem Connection
You can connect to a control interface via modem:

- Open the CCI DDE server as described in appendix A.
- Choose Configure | Control Definition
  - or-
  Double click on a 2179 group.
- Click on a group or control that you want to connect to via the modem and click on the setup button.
- At the top of the newest window, select modem connection.
- Select the modem that you wish to connect with.
- Type in the phone number to dial. Then click the ok button; your setup is complete.
- The modem will automatically connect when you start to communicate with the control.

This section assumes that your modem is successfully setup through Windows. For setting up a modem through Windows consult the Windows help. Modem support is for the 2179 protocol only.

Receive the Control Settings and Readings
While you are communicating with a control, you can receive its settings and readings.

To get the settings:
If the status shows NOT COMMUNICATING, you must start communications as described previously.

As soon as the communications start, the program gets all the settings from the control. You can examine and change the settings by selecting All Settings, Individual Settings, or Communications Settings from the Window menu.

To get a reading:
You can get a reading from the control by selecting Control | Obtain Reading from Control from the menu or clicking on the Obtain Reading From Control button on the Toolbar. If you are not already communicating with the control, the program will start communications and ask you which control you want to access.

As soon as the reading is obtained, you can view Instantaneous and Demand Metering, Status, Diagnostics, Calibration, and Profile Data information by selecting them on the Window menu.
Send Commands to a Control
While your PC is communicating with a control, you can operate the manual operations mode of the control from this program.

1. If the status shows NOT COMMUNICATING, you must start communications as described previously.
2. Choose Window | Operate from the menu. The Operate dialog will open.
3. You can see the status of the control.
   You can operate the control by clicking on the buttons.

Reset the Indicators in a Control
You can reset the indicators in the control. First click on the reset selection box to put a check mark for each item to be reset. Then press the Reset button in the dialog box or choose Control | Reset Indicators on the menu or click the reset button on the Toolbar.

You may reset marked indicators, demand metering and tap position indicators, or all indicators. Marked indicators are those that have been marked in dialogs.

Set the Control Clock
You can check and set the clock in a control. Choose Control | Set Control Clock on the menu or click the clock button on the toolbar. The current date/time in the control will be displayed.

You can set the control clock to the PC’s clock or a specified date/time.

A CL4C does not have a real-time clock, so this menu option will be disabled while communicating to a CL4C.
Chapter 6 Moving The Settings and Readings

What Can Be Moved?

Settings on an office computer may have to be moved to a notebook computer so it can be taken to a control in the field. Or settings and readings from a control may be saved on a notebook computer, but they are needed for review on a computer in an engineering office. Settings and readings may need to be copied to a central location.

Settings and readings are saved in files with an extension of “xls”. The files can be copied, moved and deleted like any other file on your PC. They can be transferred from one computer to another on diskettes, over a network or by modem connections.

The instructions below show you how to:

- Move data (settings or reading) from one file to another file on the same computer.
- Move data (settings or reading) from one computer to another computer.
- Move whole data files from one directory to another directory.
- Move whole data files from one computer to another computer.

Move Data From One File To Another File On The Same Computer

- Start the Cooper Control Interface program on the computer that has the data to be moved.
- Use File | Open Settings, File | Recent Settings, File | Open Reading, or File | Recent Reading to open the data (settings or reading) that is to be moved.
- Use File | Save As to save the data (settings or reading) in the desired file. The file can be on the local hard drive or on a network drive. The file can be a new file or it can be an existing file.
- The data will still exist in the file from where it was moved. If desired, use File | Delete Settings or File | Delete Reading to remove the data from that file.

Move Data From One Computer To Another Computer

- Start the Cooper Control Interface program on the computer that has the data to be moved (the source PC).
- Use File | Open Settings, File | Recent Settings, File | Open Reading, or File | Recent Reading to open the data (settings or reading) that is to be moved.
- Insert a diskette in the floppy drive of the source PC.
- Use File | Save As to save the data (settings or reading) to a file on the diskette. Choose the floppy drive (usually drive A) in the Save As dialog.
- The data will still exist in the file from where it was moved. If desired, use File | Delete Settings or File | Delete Reading to remove the data from that file.
- Move the diskette to the floppy drive of the computer that is to receive the data (the target PC).
- Start the Cooper Control Interface program on the target PC.
- Use File | Open Settings or File | Open Reading to open the data. Choose the floppy drive (usually drive A). Choose the file that was saved earlier.
- Use File | Save As to save the data (settings or reading) in the desired file on the target PC. The file can be on the local hard drive or on a network drive. The file can be a new file or it can be an existing file.
Move Whole Data Files From One Directory To Another Directory

If you are familiar with Windows Explorer, you can use this tool to copy files from one directory to another directory. Refer to the Windows on-line help if you need more information or look for the file copy topics in the Windows User Guide.

- Open the directory where the data file is stored on your PC (the source directory) in one panel of Windows Explorer. The directory can be on the local hard drive or on a network drive.
- Open the directory where you want to move the data file (the target directory) in another panel. The directory can be on the local hard drive or on a network drive.
- If the target directory already has a file with the same name as the file you are moving, then rename the file in the target directory. If you do not rename the file, you will lose the existing data in that file. Be sure to keep the “.xls” file extension.
- In the source directory, locate the file you want to move.
- Click and hold the mouse button while you drag the file from the source directory to the target directory.

Move Whole Data Files From One Computer To Another Computer

If you are familiar with Windows Explorer, you can use this tool to copy files from one computer to another computer. Refer to the Windows on-line help if you need more information or look for the file copy topics in the Windows User Guide.

- On the computer that has the data to be moved (the source PC), open the directory where the data file is stored (the source directory) in one panel of Windows Explorer. The directory can be on the local hard drive or on a network drive.
- Insert a diskette in the floppy drive of the source PC.
- Open the floppy drive (usually drive A) in another panel of Windows Explorer.
- Click and hold the mouse button while you drag the file from the source directory to the floppy drive.
- Move the diskette to the floppy drive of the computer that is to receive the data (the target PC).
- On the target PC, open the floppy drive (usually drive A) in one panel of Windows Explorer.
- Open the directory where you want to move the data file (the target directory) in another panel. The directory can be on the local hard drive or on a network drive.
- If the target directory already has a file with the same name as the file you are moving, then rename the file in the target directory. If you do not rename the file, you will lose the existing data in that file. Be sure to keep the “.xls” file extension.
- In the panel for the floppy drive, locate the file you want to move.
- Click and hold the mouse button while you drag the file from the floppy drive to the target directory.
Chapter 7 Troubleshooting and Operating Tips

Can't communicate with a Control
If you are unable to receive readings or settings from a control, the problem most likely will be with the cable or the setup.

First check to be sure that you have the correct cable and that it is securely plugged into the control and into the correct port on your PC. For data port connections, be sure that correct end of the Data Port-to-Computer Interface cable is plugged into the data port.

If the cable is secure, verify that you have the correct setup in the CCIDDE program. Be sure you have specified the correct control type and that the communications parameters are correct.

Reports won't print
The report printing program uses the printer you have setup in Windows. There are no parameters you need to change within the Cooper Control Interface program.

If your reports do not print properly, verify that you have the correct printer setup in Windows and use the Windows help process to identify what is wrong. Remember that other applications may be used to open and print the data.

Lost the Readings
When you receive profile data or demand metering date/time stamps from a control using the 2179 protocol, the control automatically resets the data. You must save the data to a file on your PC if you want to view the data later. You cannot retrieve the data from the control a second time using the 2179 protocol. The data can always be retrieved using the data port.

For additional troubleshooting assistance
You may contact Cooper Power Systems:

- Customer Service Center: (414) 524-3300
- Internet web address: www.cooperpower.com
- Local Cooper Power Systems Representative
Appendix A  Manually Starting The CCI DDE Server

Windows Start Menu

The installation adds the Cooper Power Systems program group to the Start menu. The DDE Server is started automatically when needed by other Cooper Control Interface programs.

To manually start the Cooper Control Interface DDE Server program, click on the Start button and select Programs. Then click Comm Server in the Cooper Power Systems program group:

```
```

Windows Desktop Shortcuts

For convenience, you can place a shortcut to the DDE Server on your Windows desktop. You can find instructions for creating shortcuts in the Windows Help on the start menu.

If you have a shortcut on your desktop, simply double-click on the icon to start the program.

Shortcut to Ccidde.exe
Appendix B  Setting Up Communications To A Control

Configuring the CCIDDE Server

The CCIDDE Server handles communications between programs on your PC and an attached control. The server is able to automatically configure the PC communications port speed to work with a control. However, you must configure some items for it.

The configurable items are described here. Consult the on-line help in the CCIDDE program for detailed instructions. To access the configuration menu, start the CCIDDE server if it is not already running. See Appendix A for instructions on how to manually start the CCIDDE server. Select Configure from the menu bar. If you will only connect to the Data Port of a control, then configuration of the DDE server will not be required for proper operation.

See the Service Information Manual for your control for more information on the communications parameters for your control.

PC Port Configuration

Choose the Configure | PC Connection menu from the CCIDDE program to setup the PC port. The program lets you set the address for the PC and select the COM port where you will connect the cable. The address defaults to 1 (one) and should not normally be changed. This identifies the PC as device number 1 in the connection.

Adding A New Control From DDE Server

You can add controls and control groups. Each control must belong to a group, and a group can consist of one or more controls.

Choose Configure | Control Definition from the CCIDDE program to add or change controls and groups.

When you define a group, you must set the protocol, group name and baud rate. You can choose AUTO Baud Rate and let the server determine the rate.

When you define a control, you must set its name and type, and you must assign it to a group. You can specify any name that will help you identify the control later.

You must specify the protocol used by the communications link. The data port uses the 2175 protocol. The communications port of the control uses either the 2200 or 2179 protocol. Controls with the 2200 protocol are supported only through the data port or the DOS based program (contact your Cooper Power Systems representative).

If the group uses 2179 protocol, you must also assign the control address. Each control in a group must have a unique address different from the PC so that the CCIDDE Server can send messages to each control individually.
Adding A New Control From The Interface Program

A new control can be added to the Data Port group of the DDE Server from the CL4/CL5 or F4C Control programs. See Making The Connection in Chapter 5 or the on-line help topic Select a Control for more information. Controls using the 2179 protocol cannot be configured from the Cooper Control Interface CL4/CL5 or F4C Control programs. These controls must be added from the DDE Server.

How The CCIDDE Server Works

The CCIDDE Server accepts DDE requests from other programs such as the CL4/CL5 or F4C Control programs. It translates the requests into the appropriate protocol for the control, sends the command or request through the communications port, reads the response from the control, and translates the response into a DDE response for the calling program.

This design allows many different programs to communicate with a control without the need for configurations and communication control in each one. The DDE server can be upgraded to provide additional protocols and support for new devices without requiring all of the accessing programs to be changed.

Using The CCIDDE Server With Other Programs

A list of DDE commands for the CCIDDE Server is available from Cooper Power Systems if you are interested in creating your own programs to access controls through the server. However, building DDE programs is a task for experts.
# Appendix C Error Code Definitions and Solutions

<table>
<thead>
<tr>
<th>Err #</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Internal error.</td>
<td>Automatically resolved.</td>
</tr>
<tr>
<td>2</td>
<td>Comm port not active.</td>
<td>The connection may have been lost. Disconnect and connect again.</td>
</tr>
<tr>
<td>3</td>
<td>Transmit buffer full.</td>
<td>The Control isn’t accepting data sent by the PC. Make sure the Control is functioning correctly and reinitialize the Control.</td>
</tr>
<tr>
<td>4–6</td>
<td>Internal errors.</td>
<td>Automatically resolved.</td>
</tr>
<tr>
<td>7</td>
<td>RS232 invalid port.</td>
<td>An invalid port was specified (i.e. COM5). Check the ‘PC Port Connection’ configuration in the DDE Server.</td>
</tr>
<tr>
<td>8–27</td>
<td>Internal errors.</td>
<td>Automatically resolved.</td>
</tr>
<tr>
<td>28</td>
<td>Error allocating memory.</td>
<td>The communications DLL was unable to allocate the required memory.</td>
</tr>
<tr>
<td>29–49</td>
<td>Internal errors.</td>
<td>Automatically resolved.</td>
</tr>
<tr>
<td>50</td>
<td>Timeout on port.</td>
<td>Retry the operation. If the problem persist, the Control may be too busy to respond to the PC. Other possibilities: 1) Make sure the DDE Server and the Control’s communications board both have the same echo settings. 2) Make sure the fiber optic cables are connected correctly (Receive to Transmit and Transmit to Receive). 3) Make sure all cables are connected securely and to the correct ports. 4) Check the port configuration on the DDE Server. 5) <strong>If all else fails, replace cables that may be damaged.</strong></td>
</tr>
<tr>
<td>51</td>
<td>Framing error in receive message.</td>
<td>Retry the operation. This may be due to a noisy connection or improperly set baud rate. If the problem persists, check the connections and make sure the baud rate set in the DDE Server is the same as the baud rate of the Control.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>------</td>
<td>----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>52</td>
<td>Overrun error in receive buffer.</td>
<td>Retry the operation. This may be due to a noisy connection or improperly set baud rate. If the problem persists, check the connections and make sure the baud rate set in the DDE Server is the same as the baud rate of the Control.</td>
</tr>
<tr>
<td>53</td>
<td>Parity error in receive message.</td>
<td>Retry the operation. This may be due to a noisy connection or improperly set baud rate. If the problem persists, check the connections and make sure the baud rate set in the DDE Server is the same as the baud rate of the Control.</td>
</tr>
<tr>
<td>54</td>
<td>Cable isn't connected correctly (CTS is low).</td>
<td>Verify that the correct cable is being used and connected correctly.</td>
</tr>
<tr>
<td>55</td>
<td>The system has timed out waiting for data that has been placed on the transmit buffer to be transmitted.</td>
<td>The Control isn’t accepting data sent by the PC. Make sure the Control is functioning correctly and reinitialize the Control.</td>
</tr>
<tr>
<td>64</td>
<td>A system error has occurred</td>
<td>The operating system has reported a problem. This is most likely due to low resources. Close any non-essential applications to make more resources available.</td>
</tr>
<tr>
<td>65</td>
<td>An invalid NULL pointer was passed.</td>
<td>This is either a program problem or the operating system has run into memory problems. Close any non-essential applications to make more resources available.</td>
</tr>
<tr>
<td>66</td>
<td>The DLL is busy processing another request.</td>
<td>Restart the DDE Server application. If the problem persists, Reboot the computer.</td>
</tr>
<tr>
<td>67</td>
<td>The Handle is already in use.</td>
<td>Close the DDE Server and re-start it.</td>
</tr>
<tr>
<td>68</td>
<td>The DLL's state machine is not in the correct state.</td>
<td>Close the DDE Server and re-start it.</td>
</tr>
<tr>
<td>69</td>
<td>The DLL’s state machine is not in the correct state or is stuck in a non-idle state.</td>
<td>Close the DDE Server and re-start it.</td>
</tr>
<tr>
<td>70</td>
<td>The Client message is invalid</td>
<td>The request received by the client is corrupted. If the problem continues, close the DDE Server and re-start it.</td>
</tr>
<tr>
<td>71</td>
<td>A client message was expected.</td>
<td>The request received by the client is corrupted. If the problem continues, close the DDE Server and re-start it.</td>
</tr>
<tr>
<td>Error Code</td>
<td>Description</td>
<td>Solution</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>72</td>
<td>An invalid command was requested.</td>
<td>The request received by the client is corrupted. If the problem continues, close the DDE Server and re-start it.</td>
</tr>
<tr>
<td>73</td>
<td>The point type was out of range. Valid range is 1-15.</td>
<td>The request received by the client is corrupted. If the problem continues, close the DDE Server and re-start it.</td>
</tr>
<tr>
<td>74</td>
<td>The point number was out of range.</td>
<td>The request received by the client is corrupted. If the problem continues, close the DDE Server and re-start it.</td>
</tr>
<tr>
<td>75</td>
<td>An invalid quantity of data was requested.</td>
<td>The request received by the client is corrupted. If the problem continues, close the DDE Server and re-start it.</td>
</tr>
<tr>
<td>76</td>
<td>The checksum on the received message was different than expected.</td>
<td>This error should correct itself. If the problem persists, make sure the DDE Server and the Control’s communications board both have the same echo settings and check the connection to the Control.</td>
</tr>
<tr>
<td>77</td>
<td>An error occurred while parsing the data received from the Control.</td>
<td>This error should correct itself. If the problem persists, check the connection to the Control.</td>
</tr>
</tbody>
</table>
Glossary

Baud Rate
The speed in bits per second for the serial data transfer between the computer and the control. See the Service Information Manuals (S225-10-4C or S225-10-10) for information about the baud rates each control supports.

Communications Port
The Communications Port is a real-time digital communications link from a control to other devices. It is not the port on the front panel of the control. See also Data Port.

Communications Protocol
The “language” used by the control and your PC when they communicate. When you configure a control in the CCIDDE program, you specify which protocol it uses. See the Service Information Manuals (S225-10-4C or S225-10-10) for information about the protocols each control supports.

The 2175 protocol is used by the data port. The 2179 protocol is the communications port protocol supported by this program. This program does not support the 2200 protocol.

Control ID
The number programmed into a control to uniquely identify it. The control ID is used to find the correct configured control when you communicate with a control and you click the Data Port button.

Control Type
Identifies the type of a control: CL-4C, CL-5A, CL-5C, CL-5D, or CL-5E.

Data Port
The front panel 9-pin port on the control where you attach the Data Port-to-Computer Interface cable. This port is NOT an RS-232 port. The Data Port uses the 2175 protocol. See also Communications Port.

Demand Metering Date/Time Stamp
The demand metering values are date and time stamped for the CL-5A and later versions of controls. Date and time stamps are not available for the CL-4C control.

Dynamic Data Exchange (DDE)
A protocol for exchanging data through active links between applications that run under Microsoft Windows.

Reading
A reading is settings plus the output of metering, load profile, and event/profile recorders in the control. The metering, load profile, and event/profile recorder data tell you how the system and device that the control operates with is performing. The Cooper Control Interface lets you receive the readings from a control so you can analyze them. You can view them on the screen and print reports. A readings file can be sent to another computer for review.
Settings

Settings are the control programming parameters that set up how the control operates. The Cooper Control Interface lets you receive the settings from a control so you can review them, change them, or save them for later use. Settings that you have changed but not saved are displayed in blue. The program also lets you create new settings and upload them to a control. A settings file on your computer can be transferred to another computer for review and modification. You can receive a settings file from someone else and upload it to a control attached to your PC.